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Online help and PDF documentation

 
Both can also be found at our customer center at customer.proxess.de (German).

The PDF documentation can be found in the local Windows help directory of the computer on which the
module is installed. 
You access the online help using the Help function in the program.
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Copyright notice, disclaimer
PROXESS has made every effort to guarantee the completeness, accuracy and timeliness of the information
contained in this document. We reserve the right to make changes to this document without notice. PROXESS
does not assume any liability for technical defects in this documentation. Furthermore, PROXESS does not
assume liability for damages that can be attributed directly or indirectly to the delivery, performance and use
of this documentation.
 
This documentation contains proprietary information that is subject to copyright. Without prior written
permission from PROXESS, this documentation may not be translated, distributed, copied or reproduced in any
other form either in whole or in part. The software described in this documentation is subject to a licensing
agreement. The use and reproduction are only permitted within the bounds of this agreement.
 
PROXESS is not liable to any person or entity for any losses or damages that are allegedly or actually and
directly or indirectly incurred in connection with the use of or impossibility of using the instructions contained
in these documents. PROXESS reserves the right to change this document without prior notice, without being
obligated to inform any persons of such changes or modifications.
 
All of the trademarks, product names and company names mentioned in this manual may be registered
trademarks of the respective owners or manufacturers. All brands and other names that do not belong to the
PROXESS software are also the property of the respective owner if no special mention is made of protected
rights in individual cases.
 
All mentioned software products are trademarks of the respective manufacturers:

PROXESS® is a registered trademark of PROXESS GmbH.
Adobe and Acrobat are trademarks of Adobe Systems Incorporated which may be registered in some
jurisdictions.
CFM Twain is a registered trademark of Computer für Menschen GmbH.
Internet Explorer, Microsoft Windows, MS Word, MS Excel, MS Powerpoint and Microsoft SQL Server
are registered trademarks of Microsoft Corporation.
Microsoft Dynamics NAV is a registered trademark of Microsoft Corporation.
Lucene is a free software project from the Apache Software Foundation.
Caché is a registered trademark of InterSystems Corporation. 
Oracle product names and the Oracle logo are registered trademarks of Oracle Corporation.
SAP/R3 is a registered trademark of SAP Software AG.
Google Chrome is a registered trademark of Google Inc.
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Conventions in this documentation
A note for female users:

For better legibility, we are omitting the explicitly separate mention of male and female users in this
documentation. However, we want to expressly point out that we always refer to both women and men.
 

Highlights in the text
Highlights are used in this documentation as follows:

Bold Refers to menu commands, buttons, field names, options and program groups.
Examples: the New command, in the Name field

“Quotation marks” Refer to menu titles, folder names and dialog fields.
Examples: the "User" menu, the "Smartcards" folder, the "Set Password" dialog box

UPPERCASE
LETTERS
 

Are reserved for the representation of keys.
Examples: RETURN key, ALT key

(Brackets)
 

Show that a placeholder symbol is meant.
Examples: (%) (_) during the PROXESS search

 

 Tip

A tip shows you particularly convenient options for operation or useful additional information.
Tips are always represented as they are in this paragraph.

  
Warning information

 

 

A warning is displayed for actions which could result in significantly more work or might even
lead to data loss or other material damages. Warnings are shown by this symbol:
You should read the warnings very carefully before you continue working.
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About the PROXESS Storage Manager Explorer
The PROXESS Storage Manager Explorer (SMX) has the following functions:

 
With the SMX, the administrator can add and burn CD/DVD blanks and easily swap out and resume CDs/DVDs
etc. The Storage Manager Explorer presents all management information of the Storage Manager so that the
processes are transparent to you. With the Storage Manager Explorer, you can see and control the current
state of the Storage Manager.
 
The Storage Manager Explorer is a client of the Storage Manager. This is why state changes of the Storage
Manager are only visible when the display in the Storage Manager Explorer is updated. For executed functions
in the SMX which change the state of the Storage Manager, the display is updated automatically.
Only one Storage Manager Explorer can be active at a time.
 

See also:
The screen layout of the Storage Manager Explorer
 

Control and monitoring of the PROXESS Storage Manager
Mounting and configuration of new storage hardware for PROXESS
Control of the connected PROXESS storage hardware
Creation and verification of the optical storage media for PROXESS, such as DVD and WORM

 PROXESS Storage Manager Explorer Documentation
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Connect command
After program startup, you first have to connect to the PROXESS Storage Manager.
 
To do so, select the Connect command in the "File" menu.
 
The following dialog box opens:
 

Figure: "Connect to Storage Manager" dialog box
 

 
Server

Here you can see the name of the local computer on which the Storage
Manager is running as the default setting. Enter the name of the computer
on which the Storage Manager to be administered is installed here. This is
generally the computer to which the storage hardware, e.g. a DVD jukebox,
is also connected.

Protocol Select the protocol for internal communication with the Storage Manager
here.

Password

Login as a user:
If you leave the "Password" field empty and click the OK command, you will
automatically be logged in to the Storage Manager Explorer as a user. This
also occurs if you enter an incorrect password. Not all functions of the SMX
are available to you as a user. Functions for configuration in particular, e.g.
the creation of a new device, are not active in this case.
 
Logging in as an administrator:
Enter the administrator password. Contact PROXESS support for this if
necessary. Then click OK to connect to the Storage Manager. All functions
of the SMX are available to you as an administrator.

_____________________________________________________________________________
See also:
Disconnect command
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The screen layout of the Storage Manager Explorer
Following installation, the Storage Manager Explorer can be found in the PROXESS/Configuration program
group.
After starting up, the title line indicates the name of the server where you are located. In the example below,
this is "LBFSRV01". First, you have to connect to the Storage Manger. Following this, you can configure the basic
properties of the Storage Manager using the context menu of this node.
The screen of the Storage Manager Explorer is similar to that of the Windows Explorer. The section on the left-
hand side displays the devices managed by the Storage Manager.
In the right-hand section of the screen, you can see a list of the elements belonging to the device which you have
selected on the left-hand side. The elements are represented by image symbols. You can choose between
various different display modes of the lists using the "View" menu.
Devices and list elements feature context menus which you can access with the right mouse button. The
context menu shows the actions which can be executed with the device/element. Each device/element
features device properties which you can view and set using the Properties command in the context menu.
The size of the window area can be changed. When you move the mouse pointer to the separator, it changes
into a double arrow with which you can move the separator.
 
If you have opened the Storage Manager Explorer and connected it to the Storage Manager, the following view
is available, for example:
 

Figure: Screen layout of the Storage Manager Explorer

 

Left-hand side Here you can see the devices managed by the Storage Manager.

Right-hand side Here you can see the device lists available for the devices on the left-hand side.
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The toolbar  

This symbol connects to the Storage Manager.

This symbol disconnects from the Storage Manager.

This symbol updates the display manually.

This symbol jumps up one level in the view.

This symbol adds a new volume.

This symbol removes an existing volume.

This symbol displays the elements with large symbols.

This symbol displays the elements with small symbols.

This symbol displays the list of elements.

This symbol displays information on individual elements in the window.

 PROXESS Storage Manager Explorer Documentation
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Storage Manager Properties dialog box
Here, you can:

 
Once you have connected to the Storage Manager Explorer, call up this dialog using the context menu of the
root node of your Storage Manager Explorer:
 

Fig.: Context menu of the root node

 
Select the Properties command.
 

Fig.: "Properties" dialog box
 

 

"General" tab  

configure the connection to the PROXESS Database Manager module
define hierarchical storage management
incorporate the PROXESS license file
specify protocols for the Storage Manager.

 PROXESS Storage Manager Explorer Documentation
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Server
Version specification of the SMX and server name of the PROXESS
server. In the case of distributed systems, the name of the server on
which the PROXESS Storage Manager is installed.

DBIL connection DBIL stands for database interface layer.

Database name
Name of the SQL database which uses the Storage Manager for
saving its settings. If the field remains empty, the default database
provided by the system, SMDB, is used.

DBIL server
Name of the server on which the PROXESS Database Manager is
installed.

Protocol
Network protocol between the Storage Manager and Database
manager (e.g. TCP/IP). If both modules are on one computer, specify
the "Local server" setting.

Number of simultaneous
connections

Number of SQL connections or SQL queries between the Storage
Manager and the SQL database of the Storage Manager (e.g. the
SMDB).
Recommendation: 10 for large systems with approx. 30 users, and
five for smaller systems 

Hierarchical storage
management

 

Also split volumes by database
(cannot be undone)

With this setting, volumes are created separately according to
PROXESS database. This setting may make sense if you are operating
a personnel archive in addition to a general archive or are running
multiple clients in a system and would also like to separate the
associated archive files from one another.

Permanently save volume
image files in image cache

With this option, you activate the HSM image cache process. This is
required in order to create a virtual "image cache" as a new device in
the next step. An image cache is reserved disk space on Blu-ray
media, for example.  

License file Path to the valid PROXESS license file

"Protocols" tab  

Selection between: 
- TCP/IP  
- Local server  
- Named Pipes

A purely local installation works efficiently with the "Local server" or
"Named Pipes" setting. 
 
For a distributed installation of the PROXESS modules on the
network, TCP/IP generally makes sense.
 
Only select those protocols supported by the underlying server.

 PROXESS Storage Manager Explorer Documentation
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What is a volume?
Volumes are the underlying management unit of the Storage Manager. Files are split up into different volumes
due to their longevity and type.
 
The capacity limit for a volume when using ISO 9660 CDs is approx. 630 MB, or about 4 GB when using DVDs.
This limit also applies for HD volumes for enabling subsequent changing of the volume type and to be able to
burn or write volumes previously opened as an HD as a CD/DVD.
 
Volumes pass through different states here. If a volume has reached its specified capacity of approx. 630 MB
or 4 GB, for example, it is closed. If it is a CD/DVD volume, it is prepared for burning and then burned. The
respective volume states are represented by symbols in the Storage Manager Explorer:
 

Fig.: List of volumes in write cache of the Storage Manager

 PROXESS Storage Manager Explorer Documentation
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Volume properties
In addition to the display of the finished volumes placed in the jukebox, the Storage Manager Explorer also
enables the display of blanks and their processing steps up to finished volume. Every volume has a Properties
dialog box, regardless of whether it is in the cache, the safe or a jukebox. By selecting the menu
commandPropertiesin the context menu of the volume, you can display it. The Properties dialog box provides
information on attributes assigned to the volume, such as media type, storage location in the jukebox, current
status, current fill level etc.
The properties of a volume can only be read.
 
 

Figure: "Volume Properties" dialog box

 

VolumeID In the VolID field, you can see the continuously incremented name of the volume.

Copy For volumes of type DVD, the set number of copies are burned during DVD creation. The
Copy field indicates which copy of a DVD currently being burned in the system is involved.

Size In the Size field, you can see how much data has currently been accumulated on the
volume.

Capacity In the Capacity field, you can see the maximum capacity of a volume.
With a volume of type HD, the capacity limit is also 4 GB so that the volume can also be
burned to a DVD if necessary.

Storage
location

In the Storage location field, you can see the drive or jukebox slot on/in which a burned
DVD in the system can be found.

Status In the Status field, you can see the current status of the medium, e.g. whether it is an open
volume or a CD/DVD which has already been burned.

 PROXESS Storage Manager Explorer Documentation
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Media
type

In the Media type field, you can see whether the volume is
- archived on the hard disk or as a DVD
or
- saved as an image file in the image cache ("image file").

Lifespan In the Lifespan field, you can see the documents which are archived on this medium.
The Storage Manager assigns the documents to certain volumes according to the various
different combination possibilities of lifespan and media type.

Source
volume

Relevant for blanks with the "Waiting to verify" status. Specifies the volume which is
burned to the blank.
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Volume states
Volumes pass through different states. The states are represented by symbols in the Storage Manager
Explorer.
 

or
Open

This is the state of a volume as long as it is writable, meaning that its
capacity has not been reached. Open volumes can generally be found
in the write cache.

or

Closed

If the capacity limit of a volume is reached, it is closed to prevent
additional writing to this volume. Closed volumes are put in a queue
for creating an image file.

or
Waiting for image

Volumes in this state are in the queue for the burning/image process.

or
Creating the image (imaging)

For volumes in this state, an image is currently being created. Only
one volume can be in this state at a time.

or
Waiting to burn/Copying

Volumes in this state are waiting for blanks in a CD/DVD jukebox,
initiation of a manual burning process or copying to the defined image
cache.

or
Creating

The creation of CDs/DVDs (original and copies) or image files is in
progress.
 

or  
Burned/Archived

The creation of CDs/DVDs is complete. The 
symbol shows you that you can remove the copies. If a jukebox is not
available for burning, the burned medium can be inserted into one of
the individual drives from the safe. The

symbol is displayed when the CD/DVD is placed in a drive.
 
When using image caches, the symbol indicates that the volume was
successfully copied and verified.
The optional creation of Blu-ray media occurs using the connected
Blu-ray hardware.
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Cache properties
If you call up the Properties command in the context menu of the write cache and click the "General Cache"
tab, you will see the following dialog box:
 

Figure: "Cache Properties" dialog box, "General Cache" tab (example)

 

General Cache tab  

Backup time window Check the Allow backup field and enter the times during which the SM
processes are paused so that backups can be made during this time.

Write/read cache
monitoring

To improve the performance of the overall system, you can set a mandatory
pause for the continual background processes. The minimum entry is 7 ms.

 PROXESS Storage Manager Explorer Documentation
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BitShifts BitShifts option group:
With the BitShift (cache) value, you can set the number of subdirectories
with which the Storage Manager works in the cache. The default setting of
"5" causes the Storage Manager to work with (25) x (25) directories (i.e.
1,024). The number of files stored in each directory determines the speed
at which the operating system can access the file structure.

With the BitShift (media) value, you can set the number of subdirectories
with which the Storage Manager works on media. The parameter should be
identical to that of the cache.
 

 The BitShift parameters may no longer be changed after the
system is set up.

Mode This dialog box is not evaluated. 
 
Files which have already been archived on a medium can no longer be
edited. Files located on a closed volume which has not yet been burned also
can no longer be edited. If a user makes changes or additions to archived
files, a new file version – and therefore a new file – is always created and
archived. It is entirely possible for the various different file versions of an
archived file to be located on different volumes and/or media. 

Migration path For the migration of data from CD to DVD, the data on the CD is compiled
into virtual DVD volumes and copied to the hard drive so that it can be
burned to DVD blanks from there. The path set here indicates the path to
the data temporarily located on the hard disk which is awaiting migration.

 

See also:

Write cache properties

Media formats

Read cache properties
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Image cache properties
The image cache is a virtual storage location. It corresponds to a specific hard drive location, either local or in
the cloud (UNC path specification) and is used for the connection of Blu-ray hardware.
 
Warning information

The requirement for use of image caches is activation of the
"Save volume image files permanently in image cache" setting in the Storage Manager
properties.

 
This setting is made in the Storage Manager Properties dialog box, which you can access using the context
menu of the root node of the SMX.
 

Fig.: Storage Manager Properties dialog box

 

Creating a new image cache

When this setting is set, you can create a new image cache as a virtual device.
 
You can always create a new device:

 

The following dialog box opens:

using the context menu of the root node with the command New Device... or

in the "Tools" menu using the command Create New Device .
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Figure: "Create New Device" dialog box

 

 

Under The Under field shows the Storage Manager and server name for which the device is
created.

Device type In this field, you select the desired device type. In this case, image cache (HSM).

Device
name

In this field, you enter a name of your choice for the device.

 

Once you have confirmed your input with OK, another dialog opens. This dialog can be called up for editing
again later on using the context menu of the respective device.
 

Fig.: Dialog box for the properties of a device of type "image cache"
 
 

Name Enter the name of the image cache here.  

Storage space Here you can see how much storage space is available on the device after you have
entered the UNC path below.  

Image cache path Enter a UNC path to the device or the hard disk for the Storage Manager here.  
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Status

Deactivated: This is an exceptional state, e.g. if a device is physically no longer
accessible.  
Activated: (normal state) The device is used by the Storage Manager for the
storage of files for retrieval access to files.  
Activated for database: This setting is currently not active.  
Closed: This status is set automatically if the volume limit is reached. The
status can also be set manually to close a volume ahead of time.  

Reserved memory Disk space for purposes other than PROXESS can be reserved here.  

Reserved for database This function is currently not active.  
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Copy Times
Call up the properties of the write cache using the context menu. You will see the dialog box shown below. On
the "Copy Times" tab, you can specify the days and times during which data is not copied to the image cache.
One reason for this could be to control the general network load.
 
 

Fig.: "Non-copying times" for the image cache
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Write cache properties
The write cache describes a hard drive in the Storage Manager server on which volumes have been collected
for burning.
 
Open the properties dialog using the context menu of the write cache:
 

Figure: Cache Properties/Write Cache dialog

 
 

Write Cache
tab

 

Name In the Name field, you can see the free memory.

 PROXESS Storage Manager Explorer Documentation
 

 
page 24 of 71 



Paths

Paths option group:
In the Local cache path field, you enter the path for storing the archived data on the
hard disk. The directory name must already have been created.

In the Image file field, you enter the local path and file name.
The entered (sub-)directories must already have been created.
 

     You cannot use UNC paths for the image file and write cache! This can
lead to problems with data transfer and data access, depending on the
individual network performance.

 

Automatically
move files to
the read
cache

If this field is checked, the Move automatically option field opens. There, you can set
how often the write cache is to be checked for data to be moved and the minimum
number of MB which have to be free in the read cache. Another check gives you the
option to log files in the current SM log file as well. You specify the SM log path under
Tools/Log settings on the "File" tab.

Basic settings  

Number of
copies

In this field, you can see the number of copies of a volume to be created when burning
to CD/DVD. The minimum entry here is 2.

Reserved
memory
(MB)

In this field, you enter the minimum size of the hard disk memory to be reserved on the
hard disk of the local computer.
Example: 
If you set 9,000 MB for a RAID system with a 16 MB capacity in the Reserved memory
field, the Storage Manager works with 7 GB for the cache from that point on.

 
See also:
Read cache properties
General cache
Media formats
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Read cache properties
 
Files are moved from the write cache to the read cache if:

The goal of the read cache is to collect files online which are as up to date as possible to reduce access times.
Every file only still found on a medium (CD or DVD) is automatically copied to the read cache during retrieval
access.
 
If you call up the properties of the read cache using the context menu, you will see the following dialog box:

Figure: "Cache Properties" (read cache) dialog box

 

Read cache
properties

 

Name In the Name field, you can enter the name of the device.

Read cache
path

In the Read cache path field, you enter a path for temporary storage of the data which
has already been archived on the hard disk. This path is different from the write cache.
In this way, you ensure the physical separation between the read and write caches. The
directory name must already have been created.

Monitor read
cache
automatically

By checking the Monitor read cache automatically check box, you can activate the
following additional settings.

Max. free
memory
(MB):

The automatic function takes effect starting with this entered value.

the files were compiled into a volume
this volume has been verified
and a backup copy of the volume has been created.
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Data remains
in cache...in
(min):

Time for which the files remain in the cache. The default value is 10080 (1 week).

Check read
cache
every...(sec):

The smallest possible entry is checking every 120 seconds.

Basic settings  

Reserved
memory
(MB)

In this field, you enter the minimum size of the hard disk memory to be reserved on the
hard disk of the local computer.
Example: 
If you set 9,000 MB for a RAID system with a 16 MB capacity in the Reserved memory
field, the Storage Manager works with 7 GB for the cache from that point on.

Minimum
cache enable
(MB)

In this field, you enter the minimum number of files enabled for deletion. Deletion of
the minimum number occurs when the available hard disk capacity minus the reserved
memory minus the upper limit of free memory is reached.

 
See also:
Write cache properties
General cache
Media formats
Image cache properties
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Expanded read cache (sub-read cache)
Sub-read caches, or expanded read caches, are then set up if a single read cache device is no loner sufficient
due to the large volume of data.
 
Warning information

        To set up an "expanded read cache," please contact PROXESS support.

 

Fig.: "Expanded Read Cache" properties dialog box

 
The following settings are possible:

Name You enter the desired designation here (e.g. Sub1, Sub2 etc.).

Free memory Specification of the free memory on the device path specified below

Read cache path
(directory
name)

In the Read cache path field, you enter a path for temporary storage of the
data which has already been archived on the hard disk. This path is different
from the write cache and the read cache. In this way, you ensure the physical
separation between the read and write caches. The directory name must
already have been created.

DB cached
status

Internal reference for retrieving the cache for the Storage Manager
Possible input: 3 – 102.

Reserved
memory

In this field, you enter the minimum size of the hard disk memory to be
reserved on the hard disk of the specified device.

Example:
If you set 9,000 MB for a RAID system with a 16 GB capacity in the
Reserved memory field, the Storage Manager works with 7 GB for the cache
from that point on.
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Advanced
properties

 

Static
This option is set automatically and cannot be deactivated. The sub-cache is
created by PROXESS support, e.g. by converting a read cache, and then
has a fixed static size.

Deactivated

If this option is active, deactivate the sub-cache. This stops access by the
Storage Manager to the files of this sub-cache.  This makes sense if the hard
disk on which the files are located is no longer being accessed, for example.
Final clearing of the sub-cache in the Storage Manager Explorer is not
possible.

External data
source

An additional external data source can be included via a URL call here.

Priority in use This option is not active.

 

____________________________________________________________
See also:
Read cache properties
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Media formats
On this page, you can select the media format which your Storage Manager is to use for the automatic
creation of new volumes for optical data media.
 
Warning information

     
Conversion from DVD back to CD is not supported.
 

 
 

Figure: "Cache Properties" dialog box, "Media Formats" tab

 
See also:
Migration
Write cache properties
General cache
Read cache properties
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Safe

 
The safe is a "virtual device." All volumes/CDs/DVDs not stored in a specific device of the Storage Manager are
displayed as "sitting in the safe."
 
This means that these volumes were previously processed by the Storage Manager, but are not currently
located in a device known to the Storage Manager.  This applies in particular for copies of volumes determined
only for replacement use due to the originals already being "online" in a device.
__________________________________________________________________
See also:
Migration of volumes from CD to DVD
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Safe Migration

 
Volumes which were migrated from CD to DVD are shown in "Safe Migration".
 
_______________________________________
See also:
Migration of volumes from CD to DVD
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Create New Device
You can create a new device

 

The following dialog box opens:

Figure: "Create New Device" dialog box

 

 

Under The Under field indicates the version of the Storage Manager and the server name.

Device type In this field, you select the desired device type.

Device name In this field, you enter the name of the device.

using the context menu of the root node with the command New Device... or

in the "Tools" menu using the command Create New Device .
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Devices in the SMX
Devices in the SMX are shown in the left-hand section of the window.

Fig.: Various devices in the SMX

 

Devices also have device properties which can be called up and changed in the "Properties" sub-menu from
the context menu.
With certain properties, changes are immediately registered by the Storage Manager and taken into account
for subsequent functions without your having to restart the system. This applies when changing the burn times
of a CD/DVD burner, for example.
In contrast to this, you have to close and restart the Storage Manager in any case if you change the supported
network protocol, for example. The system expressly informs you of this with a corresponding message. After
being restarted, the Storage Manager then reads in the new changes.
 
The devices are as follows:

Server:
The server is not actually a device, but rather the reference point for all other
devices of a Storage Manager. The name of the server generally consists of the
version information of the Storage Manager and the name of the SM server.

DVD drive:
This is a disk drive for DVDs. It can be a standalone DVD drive or a drive assigned
to a jukebox. DVD drives are identified by a drive letter through which the
operating system localizes an inserted DVD. The position of DVD drives in
jukeboxes is also determined by a number so that a DVD can automatically be
placed in the right bay.

DVD recorder:
The DVD recorder is a DVD burner. It can be standalone or integrated into a
jukebox.
Before you create a DVD recorder, you have to ensure that a device of type
adapter has already been set up.

Write cache:
The write cache describes a hard drive in the Storage Manager server on which
volumes have been collected for burning or passing on to another medium.

Read cache:
The read cache contains files which have already been compiled into volumes in
the write cache, verified and created from the backup copies. Only following a
complete transfer are the files moved from the write cache to the read cache.
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Expanded read cache (sub-read cache):

Sub-read caches and expanded read caches are then set up if a single read cache
device is no loner sufficient due to the large volume of data. To set up a sub-read
cache, please contact PROXESS support.

Image cache:

The image cache is the main virtual storage location for archived files.

It corresponds to a specific hard drive location, either local or in the cloud (UNC
path specification) and is also used for the connection of Blu-ray hardware.

Safe:
The safe is a "virtual device." All volumes/DVDs not stored in a specific device of
the Storage Manager are defined as "sitting in the safe." This means that
CDs/DVDs are not currently located in a device known to the Storage Manager,
but rather were already processed by the Storage Manager earlier on. This
applies in particular for copies of volumes determined only for replacement use
due to the originals already being "online" in a device.

Safe migration:
Volumes which were migrated from CD to DVD are shown here.
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Device properties
The properties are called up with thePropertiescommand in the context menu of the device. 
 
Some properties can be changed, e.g. the burn times of a DVD burner.
 
When the Storage Manager Explorer is started, all devices are initialized. If a device is configured incorrectly,
you will be presented with a corresponding message for this device as soon as you select
thePropertiescommand.
 
If you log in with a password, you can create and delete new devices.
 
If you log in without a password, you can only make settings.
______________________________________________________________________________

See also:

Cache properties
CD/DVD drive properties
CD/DVD recorder properties
Image cache properties
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Device and volume lists
Volume lists

For the cache, safe and jukeboxes, as well as for standalone DVD read drives, there are volume lists which are
displayed on the right-hand side by the Storage Manager Explorer. The list of a standalone DVD read drive
always only shows the currently inserted DVD. In the list for the jukebox device, you can see all inserted DVDs
known to the Storage Manager. In the cache list, you can see DVD volumes which are not yet finished and all
HD volumes.
 

Device lists

In the device lists, you can control and change the device properties using the context menu. In this way, you
can close a volume before its capacity limit is reached or convert an HD volume into a DVD volume to gain
storage space for the cache using the context menu, for example. You can also initiate the burning of DVDs via
a standalone burner using the context menu.
 
The following figure shows the list for the Storage Manager in the right half of the screen. You can see the
symbols for the device adapter, cache, port, safe and for two different jukeboxes.
 

Figure: Device list of the Storage Manager in the Storage Manager Explorer (example)
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DVD Drive Properties
If you click the right mouse button and select the Properties command in the context menu of the CD/DVD
drive device, the following dialog box opens:
 

Figure: CD/DVD Drive Properties dialog box

 

Name In this field, you can see the name of the DVD medium.

Path In this field, you can see the drive letter with which the DVD drive is to be
addressed.

Position in jukebox

This field shows the specification of the internal physical position of the DVD
drive in the jukebox.
A jukebox contains four installation bays, for example. The Storage Manager
instructs the jukebox to place the volumes in one of the four drives. The various
different drive letters are assigned numbers for internal communication
between the Storage Manager and jukebox which each correspond to a drive.
You have to enter these numbers into the Position in jukebox field.

Spin up....seconds
This field indicates the number of seconds after which a DVD which has just
been created is read, at the latest. If the time specified in this field is overshot,
the Storage Manager reports an error.

Cool-down time...seconds This field contains the time, in seconds, which elapses after a read error occurs
until a new read attempt is started.
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DVD Recorder Properties
If you click the right mouse button and select the Properties command in the context menu of the CD/DVD
recorder device, the following dialog field opens:
 

Figure: "CD/DVD Recorder Properties" dialog box

 

General
tab

 

Name You enter the name of the CD/DVD recorder in this field.

Device
type

You enter the device type of the CD/DVD recorder in this field.
Possible entries include CD/DVDR 100, CD/DVDR 400 and CD/DVDR MMC. You can
determine the device type in the SCSI Explorer, which is included in the delivery package
from Adaptec SCSI adapters.

SCSI
adapter

In the SCSI adapter field, you set the adapter to which the CD/DVD recorder is connected.

SCSI ID
You enter the SCSI ID of the CD/DVD recorder in this field. You can also determine this ID
using the SCSI Explorer.

SCSI
LUN

In this field, you set the SCSI LUN number (logical unit number), over which the recorder is
controlled. The default value is 0.

Position
This field indicates the position of the CD/DVD recorder in the jukebox. This only applies if
the burner is installed in a jukebox.

Burn
speed

In this option group, you set whether the data transfer to the CD/DVD recorder is to occur at
150, 300, 600, 900 or 1,200 KB per second.
The setting depends on the respective set CD/DVD recorder type and the configuration and
speed of your server.
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Priority
In this option group, you set the operating system priority with which the burning process is
to be carried out. The default setting is normal. Changes to this setting should only be made
after consulting with your PROXESS service contact.

Simulate
writing

With this check box, you set whether or not the laser is to be deactivated during CD/DVD
creation. This function should only be activated for testing purposes.

 
Tip

  
 
Set the Storage Manager in such a way that it does not start a burning process during data backup
or database indexing. Otherwise, there is a risk that the burning process could be interrupted.
 

   
 
If you click the "Burn Times" tab, the following dialog box opens:

Figure: "CD/DVD Recorder Properties" dialog box ("Burn Times" tab)
 

Burn Times  

Do not burn at the
following times

In the list, you can see the days and times during which burning is not to occur.

New Entry option
group  

Day of the week In this field, you enter the day of the week on which burning is not to occur.

From Hour Min
In the Hour and Min fields, you define the time from which burning is not to
occur on the specified day of the week.
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Until Hour Min
In the Hour and Min fields, you define the time until which burning is not to
occur on the specified day of the week.

 
 
If you click the "Special" tab, the following dialog box opens:

Figure: "CD/DVD Recorder Properties" dialog box ("Special" tab)
 
In the Device Information menu, you can see the device name and possible media formats. Under Settings, you
can enter a drive letter for your CD/DVD burner which has not yet been issued.
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File logging
You access this menu item via the "Tools" menu and the Log Settings entry.
 
The output of the error logs into a file can be specified here.
 

Fig.: Setting dialog for the log file

 
Different levels of logging can be set here.
 

Debug
This setting results in very detailed logging. Please only activate this level when
consulting with PROXESS support, e.g. as part of a service call.

Information
(default)

In addition to all errors and warnings, outputs information messages which don't
require access.
Example: "PROXESS server has been started"

Warning
Warnings are messages which are output during operation and which require action
on the part of the administrator as soon as possible.
Example: The disk capacity for saving files and data is nearly used up.

Error
These are error messages which do not lead to a server interruption, but absolutely
require action on the part of the administrator.
Example: DVD medium burning has failed, as the medium is defective.

Critical
The server module is stopped if a critical event occurs.
Example: No disk space available for saving, or SQL database not started/available.

 
 
Advanced properties for file logging:
 

Split file To prevent the log file from becoming too large, it can be split into parts.

Maximum
parts After reaching the maximum parts, the oldest files are overwritten.

 PROXESS Storage Manager Explorer Documentation
 

 
page 42 of 71 



Maximum size
After reaching the maximum file size in MB, a new file (part) is created. Together with
the limitation of the number of parts, you can prevent logging from taking up too
much disk space.

Path You can determine the storage location of the log file here.

View The log file specified in the path is called up.

Delete The log file (with all parts) is deleted.
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DB-Win Logging
You access this menu item via the "Tools" menu and the Log Settings entry.
 
The output of the error logs in the Windows debugger DBWin can be specified here. This generally only occurs
temporarily as part of troubleshooting.
 

Figure: "Storage Manager Logging, DB-Win "

 

Different levels of logging can be set here:

Debug
This setting results in very detailed logging. Please only activate this level when
consulting with PROXESS support, e.g. as part of a service call.

Information
(default)

In addition to all errors and warnings, outputs information messages which don't
require access.
Example: "PROXESS server has been started"

Warning
Warnings are messages which are output during operation and which require action
on the part of the administrator as soon as possible.
Example: The disk capacity for saving files and data is nearly used up.

Error
These are error messages which do not lead to a server interruption, but absolutely
require action on the part of the administrator.
Example: DVD medium burning has failed, as the medium is defective.

Critical
The server module is stopped if a critical event occurs.
Example: No disk space available for saving, or SQL database not started/available.
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Notification of error logs via e-mail
You access this menu item via the "Tools" menu and the Log Settings entry.
 
As an administrator, you can have log files sent via e-mail. The sending of emails occurs solely via SMTP, not
MAPI.
 

Fig.: Dialog box for SMTP settings for sending log files
 
 

SMTP settings for the sending of log files via e-mail:
 

Server Name or IP address of the server on which the SMTP server service is running.

Port The port setting is always 25.

Authentication Please use the default "Basic" setting here.

Name Windows user name with authorization to use the SMTP service.

Password Password of the Windows user account used above.

Sender Appears as sender of the sent e-mail.

Recipient Recipient of the e-mails sent by SMTP (e.g. the PROXESS administrator)

Messaging You can activate the e-mail messaging service here.

Test Here you can test the SMTP settings which have been made.
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Console Logging
You access this menu item via the "Tools" menu and the Log Settings entry.
The output of the error logs in the console window can be specified here.
 

Figure:  "Storage Manager Console"

 

Different levels of logging can be set here:
 

Debug
This setting results in very detailed logging. Please only activate this level when
consulting with PROXESS support, e.g. as part of a service call.

Information
(default)

In addition to all errors and warnings, outputs information messages which don't
require access.
Example: "PROXESS server has been started"

Warning
Warnings are messages which are output during operation and which require action
on the part of the administrator as soon as possible.
Example: The disk capacity for saving files and data is nearly used up.

Error
These are error messages which do not lead to a server interruption, but absolutely
require action on the part of the administrator.
Example: DVD medium burning has failed, as the medium is defective.

Critical
The server module is stopped if a critical event occurs.
Example: No disk space available for saving, or SQL database not started/available.
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Storage Manager E-mail Notification
You access this menu item via the "Tools" menu and the Log Settings entry.
 
Timetable
 
If you have selected the messaging function, you receive a notification on the status of the respective process
at the following intervals.
 

          Figure:  "Storage Manager Messaging"

 
See also:
E-mail logging
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Migration of volumes from CD to DVD
The migration of volumes from CD to DVD can occur in the safe or via the listed volumes of a jukebox. The
Migrate Volumes function call can be found in the respective context menu of both devices.
 
The migration process is identical in both cases and is shown originating from the safe here as an example:
 
To migrate your CDs to the DVD format, call up the context menu of the safe and select Migrate Volumes.
 

Figure: Migrate Volumes

 
 
A dialog box opens, in which you can select desired write format. Then start the migration with Start.
 
With the following message, the Storage Manager Explorer prompts you to insert the CD to be migrated:
 

Figure: Prompt to insert the source CD

 
 
The messages to remove the CD and insert a DVD follow:
 

Figure: Prompt to remove the source CD

 

Figure: Prompt to insert an empty DVD medium.
 

 
The following window confirms that the migration process has been started (see status):
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Figure: Migration

 
 
The following figure shows the successful conclusion of a migration. The dialog box is exited with Close.
 

Figure: Completed migration
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States of DVD blanks
The various different states of CD/DVD blanks are identified in the Storage Manager Explorer with corresponding symbols.
 

or

empty
(blank)

This is an empty blank. The volume ID of a blank is always 0. Additional blanks are uniquely identified by the copy number

 or 

Burning
(recording)

This blank was moved to the burner of a jukebox and is now being processed.

 or 

Waiting to
verify

The image file has been written with no errors, and verification against the contents of the cache (hard disk) will be carried out.

 or 

Verifying

This medium is currently being verified against the contents of the cache.

 or 

Verified

This medium has already been successfully verified against the hard disk cache. Additional copies of the volume have not been made yet,
however.

Corrupt
(junk)

This medium is a most likely corrupted blank. An error occurred either during burning or during verification. The medium can be removed from
the jukebox and, if applicable, verified for reusability.
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Media state changes
The Storage Manager Explorer only mirrors state changes upon request. It is therefore possible that not every
transition is visible in the Storage Manager Explorer, as the span of time for which a volume/medium
remained in the corresponding state is only very short.
 
The following state changes are possible:

--> or

--> 

Open --> Closed

Once a volume has reached its capacity (650 MB), it is closed by the
Storage Manager. From this point forward, its content is write-
protected.

--> 

Closed --> Waiting for image

Closed volumes to be burned enter the Waiting for image state and
remain there. Volumes in the Waiting for image state form a queue
for creating an image and subsequent burning.

 --> 

Waiting for image --> Creating
the image

As soon as all burn jobs for the last volume to be created are
complete, an image file is created for the next volume in the
Waiting for image state. The reason for this "delay" is the large
space requirement of image files (630 MB). The image file of the
previous creation job must be kept ready until the last copy of the
job is verified if verification fails and additional CDs/DVDs are to be
burned. If an image file were to be created for the next volume
before the creation of the last volume is complete, n x 650 MB
would be continually blocked by image files on the hard drive if
additional blanks were not available. In the Imaging state, the list
of all files belonging to the volume is compiled and the data of
these files is transferred to an image file which also contains the
file system required for burning ISO9660-compatible CD-
ROMs/DVD-ROMs.

--> 

Creating the image -> Waiting to
burn

When creation of the image file is complete, the volume can be
burned to CDs/DVDs. To indicate this situation, the state changes
to Waiting to burn.

--> 

Waiting to burn --> Creating

As soon as a blank is found in a jukebox with a burner, a CD/DVD is
produced from the image file. The production process in progress
indicates the Creating status here.

--> 

Empty --> Burning

An empty CD/DVD switches to the Burning state as soon as the
creation process for this CD/DVD has been initiated. The CD/DVD is
then located in a write drive and is burned with the image file of
the last volume switched to the Creating state.
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--> 

Burning --> Waiting for
verification

Once the recording process is complete, the CD/DVD medium
switches to the Waiting for verification state, which indicates that
this medium can be verified against the data located in the cache.

--> 

Burning --> Corrupt

Should an error occur while burning the CD/DVD, the CD/DVD
enters the Corrupt state, as it is extremely likely that a valid file
system which could be verified was not created. Another possible
cause is the use of a defective CD/DVD blank.

 --> 

Waiting to verify --> Verifying

In the Verifying state, the medium which was just created is
checked to determine whether all files are readable with the
mechanism used by the Storage Manager. For this purpose, the
medium is placed in a jukebox drive otherwise also used for
reading. That is, it is not read by the burner which created the
medium, but rather by any other desired read drive.

--> 

Verifying --> Verified

Every file is verified bit by bit against its original version in the
cache. Only when all files of the CD/DVD are fully identical to their
sources is verification successfully completed and the medium
switched to the Verified state. In this state, it waits until all
requested copies are in the Verified state.

 --> 

Verifying --> Corrupt

If non-matching files or non-matching parts of files are identified
during verification, the medium being created up to that point is
identified as corrupt. Another possible cause is the use of a
defective CD/DVD blank. The creation process is terminated
unsuccessfully for this copy.

 --> 

Verified --> Burned

If it was possible to successfully create the specified number of
CDs/DVDs, the media switch the volume ID to the volume ID of
their source and enter the Burned state. Also at this time, the
volume in the Burning state located in the cache (which was the
source volume) is deleted. As the volumes have now been created
successfully (including copies), the image file may be deleted as
well.

At this point in time, the SM searches for and prepares the next
volume in the Waiting for image state.

 
 
The state changes described above allow the simultaneous execution of different processes. Though only one
volume can be processed at a time, the various different steps can occur at the same time under certain
conditions. For example, a recorded DVD can be verified immediately after being created while another copy
of the volume is being created at the same time.
 
The time required for creating a volume is either ((number of copies * burn time) + verification time) or (burn
time + (number of copies * verification time)), whichever is greater.
Depending on the read drive speed, the verification of DVDs can take longer than burning, as access is
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occurring through the file system. This means that a large quantity of smaller files results in longer search
times in comparison to a small number of large files. During verification, approximately 1/4 of the
transmission rate specified by the manufacturer can be achieved on average. This means that, with an 8-speed
drive, a verification rate of 300 KB/s can be expected. This corresponds to approx. 650,000/300 seconds for
the entire DVD, that is, approximately 2,200 seconds or approximately 35 minutes per CD/DVD.
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Image file and burning
An image file is always created before a DVD is burned. The image file is used for a smooth burning process
without unintentional interruption due to excessively long wait times.
 
All data and directories to be archived on a medium (e.g. a DVD) are copied to an image file together. This
means that only a single file needs to be opened and read for the burning process. In this way, excessively long
wait times caused by laborious searching and verification processes which could threaten the burning process
are avoided. At the same time, the data from the image file is written to the DVD in the intended order.
Another advantage of the image file is that the data compiled once is available for additional copies at any
time. The image file is just as large as the DVD to be created. For the Storage Manager, this means
approximately 630 MB.
 
Depending on the connected hardware, the burning process occurs fully automatically, semi-automatically or
manually. If you are working with a jukebox, for example, you can load it with blanks. As long as blanks are
present, the burning process occurs automatically.
In the case of DVD changers with individual drives, the burning process starts automatically as soon as a blank
has been placed in the drive.
In addition, you can initiate the burning of completed volumes manually at any time should you wish to create
additional media, for example.
 

Warning information

 

Successful burning of a DVD requires a constant, steady stream of data. If the data stream is
interrupted, the blank to be burned is corrupted and the burning process fails.

 

To avoid interruptions to the data stream, DVD burners feature a "buffer" in which data is stored temporarily.
This "buffer" is supplied with data by the program/application at regular intervals, which sends it to the drive.
As soon as the "buffer" no longer has a sufficient amount of data, an error occurs: a so-called "buffer
underrun." This can occur if the computer has to wait for the completion of other device functions until it can
send data to the "buffer" again. To prevent this error, we try to minimize these wait times.
 
Wait times arise in particular when files are read one after another from one or more hard disks, for example.
In this case, the computer has to wait for the files in the system to be found, access rights to be checked etc.
every time. A list of all written files is also included at the same time, which is transferred to the created DVD
as the table of contents following the burning process. All of these processes together can cause long wait
times. In this case, the data volume most recently sent to the DVD burner is no longer sufficient for ensuring a
steady data stream to the write head for these spans of time. As the wait times are independent of the file
size, this risk is especially present when reading in a large number of very small files. Precisely this is the rule
for COLD processing, however.
 
 Tip

Settings which prevent the Storage Manager from consuming unnecessary storage space for
the image file can be found as cache parameters for the configuration settings in the "Write
cache" section of the Storage Manager Explorer.

See also:
State changes
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Disconnect command
The Disconnect command in the File menu closes the connection to the Storage Manager. This is useful if you
are logged in as a user, but would now like to log in as an administrator with a password, for example.
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File menu
In the "File" menu, you control the connection to the Storage Manager and exit the application.
 

Figure: The “File” menu

 

Connect
The Connect command connects to the Storage Manager. You can log in as a user or
administrator (see: Connect command).

Disconnect The Disconnect command closes the connection to the Storage Manager.

Exit The Exit command closes the program.
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Load Empty Blank
 
This function is only active if a DVD jukebox is connected to the system.
 
Using the Edit menu, you can load empty blanks into the DVD jukebox. The jukebox automatically places a
blank into the burn drive if a volume is ready for burning.
 

Fig.: "Load Empty Blank" function in the Edit menu
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View menu
In the "View" menu, you can select the bars which you would like to be displayed and in which form the
respective device bars are to be displayed.
 

Figure: The "View" menu

 

Toolbar
With this command, you decide whether or not you would like to see the toolbar on the
screen. If you activate displaying of the toolbar, the Toolbar command is marked with a
check.

Status
Bar

With this command, you activate or deactivate the status bar. If you activate displaying of
the status bar, the Status Bar command is marked with a check.

Large
Symbols

With the Large Symbols command, you see the elements with large symbols in the right half
of the screen.

Small
Symbols

With the Small Symbols command, you see the elements with small symbols in the right half
of the screen.

List
The List command shows you the elements in the right half of the screen one below the
other as a list.

Details
Using the Details command, you can see all list elements of a device in tabular form. Lots of
information on the respective element appears in the various different columns.

Update
With the Update command, you can update the view. State changes of the volume or
CD/DVD blanks are then displayed using the current symbols.

____________________________________
See also:
Details command
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Details command
Using the Details command in the "View" menu, you can view all information on the individual elements in the
window area.
 

Fig.: Detailed information of the elements in the right-hand area of the Storage Manager Explorer (in this example, "write cache")

 

Name
In the Name column, you can see the name of the volume. The displayed symbol shows you
whether a volume is to be burned to a CD/DVD or whether the volume is to remain on the
hard disk.

Vol-ID In the Vol-ID column, you can see the continuously incremented name of the volume.

Copy
For volumes of type CD/DVD, the set number of copies are burned during CD/DVD creation.
The Copy column indicates which copy of a CD/DVD currently being burned in the system is
involved.

Size in
KB

The Size in KB column indicates how much data has currently been accumulated on the
volume.

Capacity
The Capacity column indicates the maximum capacity of a volume.
With a volume of type HD, the capacity limit is also 630 MB so that the volume can also be
burned to a CD/DVD if necessary.

Storage
location

The Storage location column indicates the drive or jukebox bay on/in which a burned
CD/DVD in the system can be found.
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Status
The Status column indicates the current status of the medium, e.g. whether it is an open
volume or a CD/DVD which has already been burned.

Media
type

The Media type column indicates whether the volume is archived on the hard disk or as a
CD/DVD.

Lifespan
The Lifespan column indicates the documents which are archived on this medium.
The Storage Manager assigns the documents to certain volumes according to the various
different combination possibilities of lifespan and media type.

 

Additional information on the topic of lifespan can be found in the documentation on the
PROXESS Administrator Console.

 

 PROXESS Storage Manager Explorer Documentation
 

 
page 60 of 71 



Logging settings
Select the Logging Settings entry in the "Tools" menu.
Here you can make settings for the degree of logging and the output medium, as well as for potential
notification via e-mail.
In this window, you can see an overview for the currently set status of logging. You can see the output medium
for which logging is activated and the logging level which is set:
 

Figure:  "Storage Manager Logging, Overview"

 
The following are potential output media:

DB-Win
If you would like to use the DB-Win program as the output tool for your log, you can
configure it on this tab.  

Console
If you would like the logging messages to be visible in the console window, configure the
settings on this tab.

File If you would like to enter all messages in a log file, use this tab.

E-mail
Log files can be sent automatically by e-mail.
The following settings are available:

 
 
Several output media can be activated at the same time. You can also specify the magnitude of logging for
each one.
 
The following logging levels can be set.
 

Debug
This setting results in very detailed logging. Please only activate this level when
consulting with PROXESS support, e.g. as part of a service call.

Information
(default)

In addition to all errors and warnings, outputs information messages which don't require
access.
Example: "PROXESS server has been started"
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Warning
Warnings are messages which are output during operation and which require action on
the part of the administrator as soon as possible.
Example: The disk capacity for saving files and data is nearly used up.

Error
These are error messages which do not lead to a server interruption, but absolutely
require action on the part of the administrator.
Example: DVD medium burning has failed, as the medium is defective.

Critical
The server module is stopped if a critical event occurs.
Example: No disk space available for saving, or SQL database not started/available.
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Tools menu

Figure: The "Tools" menu

 

Find File
With this command, you can localize a specific file with volume and path (see Find File
command).

Calculate
File ID

With this command, you can determine the file ID of a file (see Calculate File ID command).

Create
New
Device

With this command, you can add a new device
(see Create New Device command).

Jukebox
Test

With this command, the functioning of a connected jukebox can be checked. This check
includes the controller of the jukebox robotics and the read drive lock. This menu command
is only active in Service mode.

Recorder
Test

With this command, the functioning of a connected CD/DVD recorder can be checked. The
values set for the properties of the recorder are tested here. This menu command is only
active in Service mode.

Drive
Test

With this command, the functioning of the selected CD/DVD drive can be checked. This test
includes the reading of data, as well as the function of the drive lock. This menu command
is only active in Service mode.

Error log This dialog is no longer active.

Logging
settings

Various different log output is controlled by the logging settings (error messages,
information and function calls)
(see Logging Settings command).

License
file

This command is not active. You set up the license file using the  Storage Manager Properties
dialog box.  

Timer
With this command, you can specify the time interval at which the view is automatically
updated
(see Timer command).
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See also:
Find File command
Calculate File ID command
Find File command
Timer command
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Find File command
If you click the Find File command in the "Tools" menu, the following dialog box opens. You generally only
need this function in the context of troubleshooting.
 

Figure: "Find File" dialog box
   

File ID
In this field, you enter the file ID in question. The file ID is generally output with error
messages.

VolumeID
This field indicates the volume ID on which the Storage Manager has stored the file with
the file ID being sought.

File name In this field, you can see the converted 8.3 file name given to the file on the CD/DVD.

In cache
Should the file not yet be located on a completed volume, but rather is still or again found
in the cache directory, you can see the cache name, the status of the sought file and the
path specification for the file here.

Status

0 = not in cache
1 = in write cache
2 = in read cache
3 to 100 = in sub-read cache (expanded read cache)
-1 = file ID does not exist

Search
Click this button if you have made the entry in the File ID field. Following a completed
search, the desired specifications are displayed in the Volume ID and File name fields
which previously had a gray background.

 
__________________________________________________________
See also:
Calculate File ID command
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Calculate File ID command
If you click theCalculate File ID command in the "Tools" menu, the following dialog box opens:
 

Figure: "Calculate File ID" dialog box

 

File
name

In this field, you enter the file name. Then click the OK button. The Storage Manager Explorer
then automatically calculates the file ID and displays it in the File ID field which previously had
a gray background.

File
ID

In this field, the determined file ID is displayed.

 ___________________________________________________________________________
See also:
Find File command
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Timer command
Using the Timer command, you define the frequency of automatic updates of the screen view.
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The screen layout of the Storage Manager Explorer
set path
General cache properties
Migration from CD to DVD
State changes
State changes
states
States of DVD blanks
Volume states
CD/DVD blanks
States of DVD blanks
volume
Volume states
Storage Manager
The screen layout of the Storage Manager Explorer
Storage Manager Explorer
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